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Introduction - What is ButtonMaker?
ButtonMaker provides a facility to modify the title bar buttons and scroll bar buttons.    
Predefined buttons are provided that help make Windows look similar to other Graphical 
User Interfaces.    Buttons can also be colorized and modified using standard graphic drawing
tools.

By combining the effects provided by OSFrame with the custom buttons ButtonMaker applies
to your system, you can drastically alter the appearance of Windows.

ButtonMaker achieves its magic by storing the new buttons into the display driver used by 
Windows to communicate with your video system.    The procedure has been thoroughly 
tested and is completely safe.    It does require that Windows be restarted after the new 
buttons have been applied to the driver, however.



ButtonMaker Keys
Use the following keys in ButtonMaker.

Key(s) Function
---------------------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------
-------------------------------------------------------------------------------------------------

Tab Moves forward through the tool palette.

Shift Tab Moves backward through the tool palette.

Left arrow Selects the button to the left of the current button.

Right arrow Selects the button to the right of the current button.



ButtonMaker Commands
To get help with a particular command, choose the appropriate menu.

For information on how to use Help, press F1 or choose Using Help from the Help menu.

File Menu Commands
Open...
Open Current Driver
Close
Save
Save As...
Import Button Set...
Export Button Set...
Exit

Edit Menu Commands
Undo
Copy
Paste
Restore

Options Menu Commands
No Grid
Black Grid
White Grid
Gray Grid
Light Gray Grid
Dark Gray Grid
Primary Buttons
Alternate Buttons 1
Alternate Buttons 2

Tool Menu Commands
Pencil
Fill
Rectangle
Ellipse
Line
Select
Filled Rectangle
Filled Ellipse

Button Menu Commands
Application Menu
Document Menu
Minimize
Maximize
Restore
Scroll Up
Scroll Down
Scroll Left
Scroll Right

Predefined Menu Commands



Replace all buttons
Replace title bar buttons
Replace scroll buttons
Replace current button
Windows - Standard
Windows - 3D Ctrl Menus
pseudo Mac - Flat
pseudo Mac - 3D
pseudo NeXT
pseudo OSF/Motif 1
pseudo OSF/Motif 2

Utilities Menu Commands
OSFrame...
Control Panel...
Windows Setup...
Restart Windows
Exit Windows



File Menu Commands
The File menu commands allow you to open and save display drivers.    You can also import 
and export button sets.

Open...
Closes the currently open display driver (see Close below) and presents a dialog box for 
selection of a new display driver to open.

Open Current Driver
Opens the the display driver that Windows is currently using.    This is the same driver that is 
loaded when ButtonMaker is started up.    By editing this driver and restarting Windows, you 
can quickly and easily change the appearance of Windows.

Close
Closes the currently open display driver.    If the currently loaded display driver has been 
modified, you will be prompted for permission to save the driver.    Choosing Save will save 
the driver to its current name.    If you wish to save it to a different name, choose Cancel and
then the File, Save As... menu option.

Save
Saves any edits in the the currently open display driver.    The original date and time stamp 
of the driver will be retained.

Save As...
Saves the current display driver to a different name.    Do not save the driver to the same 
name as the driver that Windows is currently using.    Doing so will make Windows hang on 
exit, and may cause the Windows environment to operate eratically.

Import Button Set...
Loads a previously exported set of buttons into the current display driver.    If the buttons 
were a different size than those in the current driver, they will be stretched to fit.

Export Button Set...
Saves all of the buttons from the currently loaded display driver into a separate file.    The 
buttons can then be imported into another driver, or can be reloaded into the current driver 
at a later time.

Exit
Closes the currently open display driver (see Close above) and terminates ButtonMaker.

-----------------
Related Topics
Exporting a Button Set
Importing a Button Set
Opening a Display Driver
Saving a Display Driver
ButtonMaker Commands



Edit Menu Commands
The Edit menu commands act on the currently selected button.

Undo
Returns the current button to the way it was before the last drawing action.    This command 
operates as a Redo also, since it treats the previous Undo as a drawing action.

Copy
Copies the currently selected portion of the button editing area to the Clipboard.

Paste
Copies the bitmap in the Clipboard to the currently selected portion of the button editing 
area.    The bitmap will be stretched or reduced to fit the current area.

Restore
Returns the currently selected button to its original appearance ( when the display driver 
was opened ).

-----------------
Related Topics
Selecting and Using a Drawing Tool
ButtonMaker Commands



Options Menu Commands
The Options menu Grid commands allow you to add and remove a grid in the button 
editing area.    The button commands are used for accessing different sizes of buttons in 
multi-resolution display drivers.

No Grid
Removes a grid from the button editing area.

Black Grid
Puts a black grid on the button editing area.

White Grid
Puts a white grid on the button editing area.

Gray Grid
Puts a medium gray grid on the button editing area.

Light Gray Grid
Puts a light gray grid on the button editing area.

Dark Gray Grid
Puts a dark gray grid on the button editing area.

Primary Buttons
Selects the base size buttons in a multi-resolution display driver.    If both of the Alternate 
Button commands are disabled, you have probably opened a single resolution driver, and 
this command does nothing.    If one of the Alternate Button command is disabled, you are 
working with a multi-resolution driver.    Select the buttons that match the size of the buttons
currently in use on your system.

Alternate Buttons 1
Allows you to select an alternate button size to edit.    Even though it is referred to here as an
alternate, it can well be the size that you are currently using.    You cannot typically change 
the size of the buttons manually, they are selected when you install a display driver.    Select 
this command if the buttons in the ButtonMaker button bar are not the same size as the one 
the system is using.

Alternate Buttons 2
This command selects another alternate button size.    See Alternate Buttons 1 above.

-----------------
Related Topics
Using a Grid
ButtonMaker Commands



Tool Menu Commands
The Tool menu commands select a tool to be used for drawing in the button editing area.    
All of the tools except for Select paint pixels using the colors selected in the color palette.    
The left button paints using the primary color, and the right mouse button paints using the 
secondary color.    The cursor will change in the editing area depending on the selected tool.

Pencil
Paints the pixel under the cursor.    Can also act as a color replacer/translator.

Fill
Paints the pixel under the cursor and adjacent pixels that are the same color.    Two different 
constraining modes are provided.

Rectangle
Draws an unfilled rectangle or square.

Ellipse
Draws an unfilled ellipse or circle.

Line
Draws a line between the pixels where the mouse button was depressed and then released.

Select
Selects a rectangular area for copying from and pasting to the Clipboard.

Filled Rectangle
Draws an filled rectangle or square.    The area will be outlined and filled using the selected 
color.

Filled Ellipse
Draws an filled ellipse or circle.    The area will be outlined and filled using the selected color.

-----------------
Related Topics
Selecting and Using a Drawing Tool
ButtonMaker Commands



Button Menu Commands
The Button menu commands select a button for editing.    The Application and Document 
control menus are color reversed when clicked on, but all other buttons have    up and down 
(depressed) images.    Windows 3.1 also provides for inactive scroll buttons, which are 
displayed when a scroll bar cannot be used.

Application Menu
The button that appears in the upper left corner of all application task windows.

Document Menu
The button that appears in the upper left corner of document (child) windows in Multiple 
Document interface applications.

Minimize
The button that reduces a window to an icon.

Maximize
The button that enlarges a window to fill the screen.

Restore
The button that reduces a window from full screen to a sizable window.

Scroll Up
The up scroll button in vertical scroll bars.

Scroll Down
The down scroll button in vertical scroll bars.

Scroll Left
The left scroll button in horizontal scroll bars.

Scroll Right
The right scroll button in horizontal scroll bars.

-----------------
Related Topics
Selecting a Button
Testing a Button
ButtonMaker Commands



Predefined Menu Commands
The Predefined menu commands allow you to quickly apply our predefined button sets to a 
display driver.    You can mix and match using the replacement mode.

Replace all buttons
Sets the button replacement mode so that all buttons will be replaced when a predefined 
button set is selected.

Replace title bar buttons
Sets the button replacement mode so that the title bar buttons (control menu, minimize, 
maximize, and restore) will be replaced when a predefined button set is selected.

Replace scroll buttons
Sets the button replacement mode so that the scroll bar buttons (up, down, left, and right) 
will be replaced when a predefined button set is selected.

Replace current button
Sets the button replacement mode so that only the current button will be replaced when a 
predefined button set is selected.

Windows - Standard
The standard Windows buttons.

Windows - 3D Ctrl Menus
Standard Windows buttons with 3D control menu buttons.    In some cases the other buttons 
are enhanced.

pseudo Mac - Flat
Buttons that do not have a 3D appearance, and capture the essence of the first popular GUI 
based computer.

pseudo Mac - 3D
Buttons that have a 3D appearance, but still capture the essence.

pseudo NeXT
A really pseudo pseudo that won't fool anyone, but can be fun anyway.

pseudo OSF/Motif 1
Title bar buttons are pretty realistic, but the scroll buttons are like a very early version and 
more similar to the standard Windows scroll buttons.

pseudo OSF/Motif 2
Same title bar buttons as Motif 1, but the scroll buttons are radically different, and more like 
the real thing.    The backgound of the scroll buttons should be colored to match the scroll 
bar color.

-----------------
Related Topics
Selecting Predefined Button Sets
ButtonMaker Commands



Utilities Menu Commands
The Utilities menu provides quick access to global Windows parameters and actions.

OSFrame...
Starts OSFrame, or brings it to the top if it is already running.    After saving changes in the 
current display driver, the new buttons will show up in the OSFrame sample window, giving 
you a preview of how the new buttons will look.

Control Panel...
Opens the Windows Control Panel program, which is used to control various system 
components such as fonts, printers, and desktop parameters.    The Desktop icon opens a 
dialog which allows you to change wallpaper, background patterns, and sizing border width.

Windows Setup...
Opens the Windows Setup program, which is used to change display, keyboard, mouse, and 
network drivers.

Restart Windows
Is equivalent to exiting Windows and then restarting it.    This command makes changes to 
the current display driver take effect, and is the easiest way to see the results of your button
changes.    This command can be useful if you have modified a system component or setting 
that requires Windows to be shutdown and restarted.    It is also useful if an errant program 
has improperly used up system resources, or caused a UAE and you're concerned about 
system integrity.

Exit Windows
Leaves Windows and returns you to a DOS prompt.

-----------------
Related Topics
Saving a Display Driver
ButtonMaker Commands



ButtonMaker Procedures
The Procedure topics give you step-by-step instructions for using ButtonMaker.

For information on how to use Help, press F1 or choose Using Help from the Help menu.

Getting Started
Exporting a Button Set
Importing a Button Set
Opening a Display Driver
Saving a Display Driver
Selecting and Using a Drawing Tool
Selecting a Button
Selecting Predefined Button Sets
Testing a Button
Using a Grid



Getting Started
ButtonMaker allows you to change the title bar and scroll bar buttons quickly and easily.    
The ButtonMaker screen has four primary components:

1)    The button bar just below the title and menu bars
2)    The button editing area below the button bar
3)    The tool palette in the bottom left corner
4)    The color palette to the right of the tool palette

When ButtonMaker is executed, it will load the current display driver automatically.    You can 
change the buttons to one of the predefined sets by using the Predefined menu 
commands.    Use the File, Save command to save any changes you have made to the 
buttons.    After saving the current display driver, you must restart Windows before you will 
see the new buttons as part of the system.

After you have mastered using the predefined buttons, you may want to create your own 
buttons, for an even more customized appearance.

-----------------
Related Topics
Opening a Display Driver
File Menu Commands
Predefined Menu Commands
Utilities Menu Commands
ButtonMaker Hints
ButtonMaker Procedures



Exporting a Button Set
You can export your button creations as a button set so that they can be recalled later, or 
used with other display drivers.    A button set is stored in a file with a default extension of 
BTN.

Select the File, Export Button Set... command and a dialog box will be presented to name
the resulting file.    After entering the name in the File Name box and selecting the directory 
where the file is to be stored, press the OK button.    If a file with the same name exits, you 
will be prompted for permission to overwrite it.

All of the buttons are stored in the file, and the button set file can be used with other display
drivers, or shared with other ButtonMaker users.

When naming button sets, you can use the following prefixes to help identify the types of
buttons contained in the button set:

W -    standard Windows
W3 -    Windows with 3D control menus
M -    flat Mac
M3 -    3D Mac
N -    NeXT
O -    OSF/Motif 1
X -    OSF/Motif 2

-----------------
Related Topics
Importing a Button Set
File Menu Commands
ButtonMaker Procedures



Importing a Button Set
You can load a previously exported button set, using the File, Import Button Set... 
command.    You will be presented with a dialog box to select the button set to be imported.   
Press OK after you have selected the button set file.

If the buttons in the button set file were created for a driver using a different size of buttons,
ButtonMaker will stretch or shrink the buttons to fit.    This will usually not yield great results, 
but you can see basically what the buttons look like.

-----------------
Related Topics
Exporting a Button Set
File Menu Commands
ButtonMaker Procedures



Opening a Display Driver
To open the current display driver that Windows is using for button modification:

Choose File, Open Current Driver.

Some Windows applications may interfere with opening the current display driver.    If you 
attempt to open the current display driver and get an error message, you are using a utility 
that has modified your SYSTEM.INI file.    You will have to manually open the display driver, 
and you may have to look at your SYSTEM.INI file to determine the name of the display 
driver you are using.

To open other display drivers for button modification:

1. Choose File, Open....

The Files box contains a list of drivers in the current directory.    The initial directory for 
display drivers is the WINDOWS\SYSTEM directory.    To see a list of drivers in another 
directory, select the directory from the Directories box, or type the name of the directory 
in the File Name box and press the Open button.

2. Type the name of the display driver you want to open in the File Name box, or select the 
display driver you want to open in the Files box.    You can double click on a file to select 
and open it in one step.

3. Press the OK button.

You will receive an error message if the file you attempt to open is not a Windows display 
driver.

-----------------
Related Topics
Saving a Display Driver
File Menu Commands
ButtonMaker Procedures



Saving a Display Driver
After applying a predefined button set to a driver, or after you have created your own 
buttons, you will need to save the display driver that is open.

If opened the current display driver, you can use the File, Save command to save your 
work.    Restarting Windows will activate your button changes.

You can also use File, Save As... to save the modified display driver under a different 
name.    This will create a copy of the original driver, but with the new buttons in it.

If you opened a different driver than you actually want to save the buttons into, you can use 
the File, Export Button Set... command to export the buttons into a button set file.    They 
can then be imported into the proper driver.

-----------------
Related Topics
Opening a Display Driver
Importing a Button Set
Exporting a Button Set
File Menu Commands
Utilities Menu Commands
ButtonMaker Procedures



Selecting and Using a Drawing Tool
Click on a tool in the tool palette to select it.    You can also use the Tool menu commands.

Before drawing with the tool, you will need to select the colors to be used.    Click in the color
palette with the left mouse button to select the left button color, and click with the right 
mouse button to pick the right button color.

Position the mouse cursor to the pixel in the editing area where the drawing action will take 
place.    The mouse cursor will show the tool to be used while the cursor is over the editing 
area.    Click the mouse button that corresponds to the color you want to use, and drag the 
mouse.    If the change is not what you want, use the Edit, Undo command before clicking in
the editing area again.

-----------------
Related Topics
Using a Grid
ButtonMaker Tools
Tool Menu Commands
ButtonMaker Procedures



Selecting a Button
Click on the desired button in the button bar, or use the left and right arrows to select it.    
Clicking with the mouse is preferable since redrawing a button in the editing area is a 
relatively time consuming operation.

-----------------
Related Topics
Testing a Button
Button Menu Commands
ButtonMaker Procedures



Selecting Predefined Button Sets
ButtonMaker provides several different types of predefined buttons.    You can use them as 
they are, mix and match them, or use them as a basis for your own creations.

1. Select the replacement mode.    The replacement mode is controlled using the 
Predefined menu.

2. Select the type of buttons to replace the selected buttons.    The button sets are also 
available on the Predefined menu.

-----------------
Related Topics
Predefined Menu Commands
ButtonMaker Procedures



Testing a Button
Windows gives visual feedback when the title bar and scroll bar buttons are clicked on.    The 
application and document control menus simply have their colors reversed.    The rest of the 
buttons use an up image and a depressed image to create the illusion that the button has 
been physically pressed.    While you are designing new buttons it is convenient to see how a
button will look when the user clicks on it.    You can test buttons by clicking on them in the 
button bar.    The first time you click on a button, it will be selected for editing.    Subsequent 
clicks will show how the button will look when it is clicked on.    The depressed images will 
not change when clicked on, since they are not normally exposed.

-----------------
Related Topics
Selecting a Button
Button Menu Commands
ButtonMaker Procedures



Using a Grid
Using a grid can make it much easier to draw new buttons.    Five different colors of grids are 
provided.    As your new button takes shape, you may want to switch among the colors.    The
grid color is controlled by the Options menu commands.

-----------------
Related Topics
Options Menu Commands
ButtonMaker Procedures



ButtonMaker Tools
To get help with a particular tool, choose the appropriate tool.

Pencil
Fill
Rectangle
Ellipse
Line
Select
Filled Rectangle
Filled Ellipse



Pencil Tool

Paints the pixel under the cursor.

Place the cursor on the pixel to be changed and press the mouse button corresponding to 
the color desired.    Drag the cursor with the mouse button down to draw free-hand lines and 
other shapes.

-----------------
Related Topics
Selecting and Using a Drawing Tool
Edit Menu Commands
Tool Menu Commands
ButtonMaker Tools



Fill Tool

Paints the pixel under the cursor, and all adjacent pixels that are the same color as the pixel 
under the cursor.

Place the cursor on the pixel to be changed and press the mouse button corresponding to 
the color desired.    Hold down a shift key to limit the fill to horizontally and vertically 
adjacent pixels of like color.    This prevents 'spill-through' on diagonal boundaries.

-----------------
Related Topics
Selecting and Using a Drawing Tool
Edit Menu Commands
Tool Menu Commands
ButtonMaker Tools



Rectangle Tool

 Draws a hollow rectangle or square.

Place the cursor on one corner of where the rectangle is to be drawn and press the mouse 
button corresponding to the color desired.    Drag the cursor, with the mouse button down, to
the opposite corner and release the mouse button.    The rectangle will then be drawn.

This tool always draws a rectangle, even if it is only a single pixel.    If you picked the wrong 
starting point, use the Edit, Undo command to remove the unwanted rectangle.

-----------------
Related Topics
Selecting and Using a Drawing Tool
Edit Menu Commands
Tool Menu Commands
ButtonMaker Tools



Ellipse Tool

 Draws a hollow ellipse or circle.

Place the cursor on one corner of where the ellipse is to be drawn and press the mouse 
button corresponding to the color desired.    Drag the cursor, with the mouse button down, to
the opposite corner and release the mouse button.    The ellipse will then be drawn.    The 
corners, as they are referred to here, are the corners of a rectangle that would contain the 
ellipse.

This tool always draws a ellipse, even if it is only a single pixel.    If you picked the wrong 
starting point, use the Edit, Undo command to remove the unwanted ellipse.

-----------------
Related Topics
Selecting and Using a Drawing Tool
Edit Menu Commands
Tool Menu Commands
ButtonMaker Tools



Line Tool

 Draws a line between the pixels where the mouse button is depressed and then released.

Place the cursor on one end point of where the line is to be drawn and press the mouse 
button corresponding to the color desired.    Drag the cursor, with the mouse button down, to
the other end point and release the mouse button.    The line will then be drawn.

This tool always draws a line, even if it is only a single pixel.    If you picked the wrong 
starting point, use the Edit, Undo command to remove the unwanted line.

-----------------
Related Topics
Selecting and Using a Drawing Tool
Edit Menu Commands
Tool Menu Commands
ButtonMaker Tools



Select Tool

 Selects a rectangular area for copying to the Clipboard, and for pasting from the Clipboard.

Place the cursor on one corner of the rectangle to be selected and press amouse button.    
Drag the cursor, with the mouse button down, to the opposite corner and release the mouse 
button.

-----------------
Related Topics
Selecting and Using a Drawing Tool
Edit Menu Commands
Tool Menu Commands
ButtonMaker Tools



Filled Rectangle Tool

 Draws an filled rectangle or square.    The area will be outlined and filled using the selected 
color.

Place the cursor on one corner of where the rectangle is to be drawn and press the mouse 
button corresponding to the color desired.    Drag the cursor, with the mouse button down, to
the opposite corner and release the mouse button.    The rectangle will then be drawn.

This tool always draws a rectangle, even if it is only a single pixel.    If you picked the wrong 
starting point, use the Edit, Undo command to remove the unwanted rectangle.

-----------------
Related Topics
Selecting and Using a Drawing Tool
Edit Menu Commands
Tool Menu Commands
ButtonMaker Tools



Filled Ellipse Tool

 Draws a filled ellipse or circle.    The area will be outlined and filled using the selected color.

Place the cursor on one corner of where the ellipse is to be drawn and press the mouse 
button corresponding to the color desired.    Drag the cursor, with the mouse button down, to
the opposite corner and release the mouse button.    The ellipse will then be drawn.    The 
corners, as they are referred to here, are the corners of a rectangle that would contain the 
ellipse.

This tool always draws a ellipse, even if it is only a single pixel.    If you picked the wrong 
starting point, use the Edit, Undo command to remove the unwanted ellipse.

-----------------
Related Topics
Selecting and Using a Drawing Tool
Edit Menu Commands
Tool Menu Commands
ButtonMaker Tools



ButtonMaker Hints
The easiest way to use ButtonMaker is to make changes in the current display driver, save 
the changes, and restart Windows.    This way you don't have to worry about changing your 
display driver using the Windows Setup program, or by doing it manually.

Our predefined buttons are reasonable facsimiles of those used on operating systems they 
are designed to mock.    But, you can creatively combine and colorize the buttons to create 
your own new look.    Try mixing and matching if you want something different without a lot 
of effort.

After experimenting with colorizing the existing buttons, or creating your own, you will find 
that certain colors work well for edge and shadow colors.    Typically you will use lighter 
colors like white or light gray for edges.    Dark Gray and Black are neutral and work well for 
shadow colors.    Darker versions of a face color don't always work well for shadow colors.    
Use the Fill tool to experiment with different combinations quickly.

Keep in mind that the Fill tool has two constraining modes.    A lot of drawing programs only 
have one mode, so you may have to get used to the additional flexibility.    By default it 
colors all adjacent pixels, which is very convenient for colorizing buttons like the Mac scroll 
buttons, but is doesn't work for filling non-rectangular areas, like the inside of the Mac 
arrows.    Use the shift key to constrain the fill.

You can speed up the drawing of the editing area by not having the ButtonMaker main 
window maximized.    The smaller the editing area is, the faster it will draw.    There is a 
practical minimum size of course.    ButtonMaker saves its screen location and maximized 
state on exit.



ButtonMaker License Agreement Information
Copyright © 1991-1992 Playroom Software.    All Rights Reserved.

ButtonMaker is a component of the Makeover for Windows utility program package.

The use of ButtonMaker is covered by the Makeover license agreement.    ButtonMaker is 
copyrighted property belonging to Playroom Software, and may only be used per the terms 
of the license agreement.    Any other use is a violation of United States Federal Copyright 
laws.

Should you have any questions concerning the agreement, or if you wish to contact 
Playroom for any reason, please write Playroom Software / 7308-C East Independence Blvd. /
Suite 310 / Charlotte, NC    28227 / (704)-536-3093.



Terms



Drop-down list box
A single line list box that opens to display a list of choices.    Use the up or down arrows to 
make a selection, or press the down arrow with the mouse and click on an item in the list.



Edge
The brighter color on the top and left sides of a raised object that occurs when light is 
striking the object from the top left.



Sample Window
The area of the OSFRAME program that shows how Windows will look with a color scheme.    
It is also used to select a screen element for a color change.    Position the mouse over the 
area to be changed and click.



Shadow
The darker color on the right and bottom sides of a raised object that occurs when light is 
striking the object from the top left.




